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Welcome

Introduction

Welcome to PowerTeacher! PowerTeacher contains the PowerTeacher gradebook, a full-
featured grade-keeping application used to record, report, and monitor student
performance.

With these powerful communication tools, everyone stays connected: teachers can use their
gradebook to make decisions on what information they want to share with parents, students
stay on top of assignments, and parents are able to participate more fully in their student’s
progress.

Quick Start

To get started immediately and begin taking advantage of PowerTeacher gradebook,
perform the following tasks to set up and use the application. See the respective sections
for detailed procedures.

Getting Started
Open PowerTeacher Gradebook

PowerTeacher Gradebook Window

Categories
Predefined Categories

Work with Categories

Assignments
Work with Assignments

Publish Assignments

Final Grades
Define Final Grade Setup

Scores and Other Information

Work with Scores (Scoresheet)

Work with Assignment Scores (Score Inspector)
Work with Final Scores (Score Inspector)

Work with Assignment Status (Scoresheet)

Welcome 1
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Work with Assignment Status (Score Inspector)
Work with Final Grade Comments (Score Inspector)

Work with Score Comments (Score Inspector)

Quit PowerTeacher Gradebook

Quit PowerTeacher Gradebook

Quick Entry Tips

To help you to quickly accomplish tasks you perform frequently, you can use the following
quick entry tips, which include a number of shortcut keys. Shortcut keys consist of pressing
one or a combination of keys on the keyboard to complete a task. See the respective
sections for detailed procedures.

Scoresheet Keyboard Shortcuts

Task Shortcut (Windows®) Shortcut (Mac®)

Assignments: Do one of the following:
Assign 100% of

points possible e Enter an equal sign (=) and press ENTER to assign

100% of points possible for the assignment

e Open the Score Inspector and enter an equal sign (=)
in the Score field

Collected: Mark Do one of the following:

or clear1a e Enter Col in the score field (repeat to remove)
student’s

assignment as e Enter a period (.) in the score field (repeat to
collected remove)

¢ Right-click in the score field and select Collected
(repeat to remove)

e Open the Score Inspector and select the Collected
checkbox (deselect the checkbox to remove)

e Use the Fill Scores command to apply to multiple
students

Comments: Add Do one of the following, and enter comments in the Comment

a comment to a field:

student’s « Press and hold CTRL+SHIFT+1

assignment score

e Right-click in the score field and select Show
Score Inspector

e Use the Fill Scores command to apply to multiple
students

Comments: Add Do one of the following and enter comments in the Comment
a comment to a field:
student’s final

Welcome 2
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Task

Shortcut (Windows®)

Shortcut (Mac®)

grade

Double-click a student’s final grade
Press and hold CTRL+SHIFT+I1

Right-click a final grade and select Show Score
Inspector

Use the Fill Scores command to apply to multiple
students

Exempt: Mark a

Do one of the following:

stuglent S e Enter Ex in the score field
assignment as
exempt ¢ Right-click in the score field and select Exempt
e Open the Score Inspector and select the Exempt
checkbox
e Use the Fill Scores command to apply to multiple
students
Fill Scores: Do one of the following:

Assign a score,
comment, and/or
flag (late,
collected,
missing, exempt)
to multiple
students for an
assignment

Right-click in the score field and select Fill Scores

Select Fill Scores from the Tools menu

Late: Mark or
clear a student’s
assignment as
late

Do one of the following:

Enter Lt in the score field (repeat to remove)

Enter an asterisk (*) in the score field (repeat to
remove)

Right-click in the score field and select Late
(repeat to remove)

Open the Score Inspector and select the Late
checkbox (deselect the checkbox to remove)

Use the Fill Scores command to apply to multiple
students simultaneously

Missing/Not
Handed In: Mark
or clear a
student's
assignment as
missing

Do one of the following:

Enter Mi in the score field (repeat to remove)

Enter a forward slash (/) in the score field
(repeat to remove)

Right-click in the score field and select Missing
(repeat to remove)

Open the Score Inspector and select the Missing
checkbox (deselect the checkbox to remove)

Use the Fill Scores command to apply to multiple

Welcome
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Task

Shortcut (Windows®)

Shortcut (Mac®)

students simultaneously

Override a Final
Grade

Do one of the following and select the Manual Override

checkbox:

e Double-click a student’s final grade
e Press and hold CTRL+SHIFT+I

¢ Right-click a final grade and select Show Score

Inspector
Zoom In Do one of the following:
e Click a final grade field or assignment header and
press and hold CTRL+SHIFT+=
e Select Increase on the View menu
Zoom Out Do one of the following:

e Click a final grade field or assignment header and
press and hold CTRL+SHIFT+-

e Select Decrease on the View menu

Score Inspector Keyboard Shortcuts

Task

Shortcut (Windows)

Shortcut (Mac)

Navigate to the
next assignment

Press and hold
CTRL+ALT+RIGHT ARROW

Press and hold
CTRL+OPTION+RIGHT
ARROW

Navigate to the
next student

Press and hold
CTRL+ALT+DOWN ARROW

Press and hold
CTRL+OPTION+DOWN
ARROW

Navigate to the
previous
assignment

Press and hold
CTRL+ALT+LEFT ARROW

Press and hold
CTRL+OPTION+LEFT
ARROW

Navigate to the
previous student

Press and hold
CTRL+ALT+UP ARROW

Press and hold
CTRL+OPTION+UP ARROW

Open Score
Inspector

Do one of the following:

e Right-click in a score field and select Score Inspector
e Press and hold CTRL+SHIFT+I

e Select Score Inspector from the Tools menu

Welcome




Main Menu Keyboard Shortcuts

Gradebook User Guide

Task Shortcut (Windows) Shortcut (Mac)

Copy Press and hold CTRL+C Press and hold COMMAND+C
Cut Press and hold CTRL+X Press and hold COMMAND+X
Hide other Press and hold ALT+TAB Press and hold

application OPTION+COMMAND+H
windows

Hide Press and hold ALT+TAB Press and hold COMMAND+H
PowerTeacher

Gradebook

window

Open Press and hold CTRL+SHIFT+2

Assignments

window

Open Categories
window

Press and hold CTRL+SHIFT+C

Open Class Info
window

Press and hold CTRL+SHIFT+5

Open Grade
Scales window

Press and hold CTRL+SHIFT+G

Open Grade
Setup window

Press and hold CTRL+SHIFT+4

Open Gradebook |Press F1 Press and hold COMMAND+?
online help

Open New Press and hold CTRL+N Press and hold COMMAND+N
Gradebook

window

Open Reports
window

Press and hold CTRL+SHIFT+6

Open Score
Inspector

Do one of the following:

e Right-click in a score field and select Score Inspector
e Press and hold CTRL+SHIFT+I

Open Scoresheet
window

Press and hold CTRL+SHIFT+1

Open Students
window

Press and hold CTRL+SHIFT+3

Open the
Preferences

Press and hold CTRL+,

Press and hold COMMAND+,

Welcome
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Task Shortcut (Windows) Shortcut (Mac)

window

Paste Press and hold CTRL+V Press and hold COMMAND+V
Quit Press and hold ALT+F4 Press and hold COMMAND+Q
PowerTeacher

Gradebook

Recalculate Final
Scores

Press and hold CTRL+SHIFT+R

Revert (discard
unsaved
changes)

Press and hold CTRL+R

Press and hold COMMAND+R

Save

Press and hold CTRL+S

Press and hold COMMAND+S

Welcome
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Get Started

About Getting Started

To get started, you must launch PowerTeacher gradebook.

Launch PowerTeacher Gradebook
PowerTeacher gradebook is accessible via the Gradebook button.

Note: If you experience a loss of connection, please check your network connection or
contact your system administrator.

How to Launch PowerTeacher Gradebook
1. Click Gradebook. The PowerTeacher Gradebook Launch page appears.

2. Click Launch Gradebook. The Downloads window appears, accompanied by a
certificate window.

3. Click Trust. The Java Web Start and Gradebook version windows briefly appear.
Then, PowerTeacher gradebook opens.

Note: You can have only one active session of PowerTeacher gradebook launched at a
time. If you attempt to launch a second session of PowerTeacher gradebook, the
Terminate Other Sessions window appears, displaying the message, "Other active
sessions exist for this user account. Would you like to terminate the other sessions or
quit this session?" Click either Terminate Other Sessions or Quit.

Note the PowerTeacher gradebook icon that appears in the dock and the
launchGradeBook.jnlp file that appears on your desktop. Both will be discarded
automatically when you quit PowerTeacher gradebook.

4. Close the Downloads window.

View Main PowerTeacher Gradebook Window

When you launch PowerTeacher gradebook, the main PowerTeacher Gradebook window
appears. This window serves as the central point from which you begin your gradebook
session.

The PowerTeacher Gradebook window consists of the following main areas:
e Menu Bar
e |ID Bar
e Classes
e Student Groups
e Navigation Bar

The PowerTeacher Gradebook window has four panes, Classes, Student Groups, the
selected tab from the navigation bar, and its details. Each pane is adjustable, both

Get Started 7
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horizontally and vertically. To adjust the width of a pane, click and hold the vertical three-
line icon and drag right or left. To adjust the height of a pane, click and hold the horizontal
three-line icon and drag up and down.

Menu Bar

The menu bar appears at the top of your display and provides access to the following
menus:

Feature Description
PowerTeacher Use the pop-up menu to select one of the following commands:
Gradebook

e Preferences
¢ Hide PowerTeacher Gradebook

e Quit PowerTeacher Gradebook

File Use the pop-up menu to select one of the following commands:
e Save
e Revert

Edit Use the pop-up menu to select one of the following commands:
e Cut
* Copy
e Paste

View Use the pop-up menu to select one of the following commands:

e Scoresheet

e Assignments
e Students

e Grade Setup
e Class Info

e Reports

e ZOoOMm

Tools Use the pop-up menu to select one of the following commands:
e Categories

e Grade Scales

e Score Inspector

e Fill Scores

e Recalculate Final Scores

e Copy Assignment

Get Started 8
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Feature Description

Window Use the pop-up menu to choose New Window to open
another instance of gradebook so that you can access other
areas of gradebook at one time.

Help Use the pop-up menu to select one of the following commands:

e Choose Contents to launch online help. For more
information, see Launch PowerTeacher Gradebook
Help.

e Choose Quick Entry Tips to view keyboard shortcuts.
For more information, see Quick Entry Tips.

Note: The PowerTeacher gradebook help window is also
accessible by clicking the Help icon, which looks like a question
mark.

ID Bar

The ID bar appears at the top of the PowerTeacher Gradebook window and displays your
name and the name of your school.

Classes

The Classes pane appears in the upper-left corner of the PowerTeacher Gradebook window
and includes the Term Selector and Class List. For more information, see Classes.

Student Groups

The Student Groups pane appears in the lower-left corner of the PowerTeacher Gradebook
window and displays student groups for a selected class. For more information, see
Student Groups.

Navigation Bar

The navigation bar appears at the top of the PowerTeacher Gradebook window and provides
a quick way to access the following areas:

Feature Description

Scoresheet Click this tab to access the Scoresheet window.
Assignments Click this tab to access the Assignments window.
Students Click this tab to access the Students window.
Grade Setup Click this tab to access the Grade Setup window.

Get Started 9
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Feature Description
Class Content Click this tab to access the Class Content window.
Reports Click this tab to access the Reports window.

Zoom In or Out of Window

PowerTeacher gradebook provides a zoom feature, which provides you with the flexibility to
zoom in to see more detail of a window or zoom out to see more of the window at a reduced
size. The zoom feature is available when using the Students, Assignment, Grades Setup,
and Scoresheet windows. After a zoom level is selected, that zoom level becomes the
default setting and applies to all four windows until you select a new zoom level.

How to Use the Zoom Feature
From the gradebook menu bar, do one of the following:

e Choose View = Zoom > Increase to zoom in. Increments are based on the preset
zoom levels.

e Choose View = Zoom > Decrease to zoom out. Increments are based on the
preset zoom levels.

e Choose View = Zoom and a zoom level.

Note: For additional entry options, see Quick Entry Tips.

Verifty Password

If your session has timed out, you may be asked to re-enter your password to continue
working.

How to Verify the Password
1. On the Verify Password window, enter your password.
2. Click OK.
Note: Alternately, you can press ENTER or RETURN on your keyboard.

Get Started 10
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PowerTeacher Gradebook Help

About PowerTeacher Gradebook Help

PowerTeacher gradebook help provides comprehensive information on navigating and using
PowerTeacher gradebook.

Set Browser Preferences

Before you begin using PowerTeacher gradebook help, check your browser preferences to
make sure your browser is set to open in a new window.

Note: If you do not set your browser to open in a new window, the help window launches in
the existing open window, replacing PowerTeacher.

How to Set Browser Preferences for Firefox

1.
2.

Open Firefox.

From the menu bar, choose Firefox > Preferences (Mac) or Tools > Options
(PO).

Click Tabs.
In the New pages should be opened in section, select the a new window option.

Close the window.

How to Set Browser Preferences for Internet Explorer

Note: For PC users only.

a h W N

Open Internet Explorer.

From the menu bar, choose Tools = Internet Options.

Click General.

In the Open links from other programs in section, select the A new window option.
Click OK.

How to Set Browser Preferences for Safari

Open Safari.

From the menu bar, choose Safari > Preferences (Mac) or Edit > Preferences
(PC).

Click General.
In the Open links from applications section, select the in a new window option.

Close the window.

PowerTeacher Gradebook Help 11
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Launch PowerTeacher Gradebook Help

After you have launched PowerTeacher gradebook, you can then launch the PowerTeacher
gradebook help window from the menu bar, by using the command keys, or simply clicking
the Help icon, which looks like a question mark.

How to Launch PowerTeacher Gradebook Help
Do one of the following:
e From the gradebook menu bar, choose Help > Contents.
e Press COMMAND+SHIFT+? (Mac).
e Press F1 (Windows).
e Click the Help icon.

Note: You can resize the help window and move the help window to a convenient location
on your desktop, so you can work with PowerTeacher gradebook. The PowerTeacher
gradebook help window remains open until you choose to close it.

PowerTeacher Gradebook Help Window

The PowerTeacher gradebook help window is divided into two panes, the navigation pane on
the left and the topic pane on the right.

Navigation Pane

The navigation pane on the left contains the Contents, Index, and Search tabs, as well as
navigation buttons you use to access and navigate the help topics.

Contents Tab

The Contents tab shows the organization of the help into folders. Each folder contains
related topics with conceptual and procedural information.

e Click Contents to view a complete list of the different folders.
e Click a folder to show the topics related to that section.

e Click the folder again to hide the topics related to that section.
e Click a topic to view the information in the topic pane.

e Click X to hide the navigation pane.

Index Tab

The Index tab provides a way to search for information interactively. The index behaves
differently depending on the computer you are using.

e If using Mac, topics are sorted by alphabetical listing. Click the letter that
corresponds to the first letter of the index entry you want, and then click the topic.
The information appears in the topic pane.

PowerTeacher Gradebook Help 12
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e If using Windows, a text field appears. Click Index and enter a keyword or phrase in
the text box. The topics containing the index term display below the text box. Click
the appropriate topic and the information appears in the topic pane.

Search Tab

The Search tab provides a way to locate occurrences of a specific word or phrase in the
help. Click Search, enter a keyword or phrase in the text box, and then click Go. The topics
containing the search phrase display below the text box. Select the appropriate topic and
the information appears in the topic pane.

Topic Pane

The topic pane on the right displays individual help topics, such as information about
PowerTeacher gradebook concepts or step-by-step procedures for using specific
PowerTeacher gradebook features.

If you access the PowerTeacher gradebook help window from the menu bar or by using the
command keys the topic pane displays the first topic within the PowerTeacher gradebook
help, the Introduction section.

If you access the PowerTeacher gradebook help window by clicking the Help icon, the topic
pane displays context sensitive information specific to the PowerTeacher gradebook window
you are viewing, including:

e How do I display this window?
e What is the purpose of this window?
¢ What can | do on this window?

¢ What do the field on this window mean?

Links

Within help topics are links to additional information or procedures. These links display as
underlined text. Click the underlined text to display the additional information.
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Spell Check

About Spell Check

Spell check is an optional feature that you can use to identify misspelled or questionable
words. When a misspelled or questionable word is identified, you have the basic option of
changing the word in one instance or all instances, ignoring the word in one or all instances,
or adding the word to your dictionary. There are two ways to use spell check, either
automatically or by using Check Spelling from the gradebook menu bar.

Note: Spell check is available for the following PowerTeacher gradebook fields: assignment
Name and Description, Category Name and Description, Assignment Score Inspector
and Final Score Inspector Comment.

Turn Spell Check On or Off

Use the Spell Check tab on the Preferences window to turn spell check on and off.

How to Turn Spell Check On or Off

1. From the gradebook menu bar, choose Gradebook > Preferences. The
Preferences window appears.

Click the Spell Check tab. Spell Check preference information appears.
Do one of the following:

e Select the Enabled background checking checkbox to turn automatic spell
check on.

e Deselect the Enabled background checking checkbox to turn automatic
spell check off.

4. Click OK to save your changes.

Note: Alternately, you can press ENTER or RETURN on your keyboard.

Manage Your Dictionary

Use the Spell Check tab on the Preferences window to customize your spell check
dictionary by adding, editing, or deleting words.

How to Manage Your Dictionary

1. From the gradebook menu bar, choose Gradebook > Preferences. The
Preferences window appears.

Click the Spell Check tab. Spell Check preference information appears.
Edit the information as needed.
Click OK to save your changes.

Note: Alternately, you can press ENTER or RETURN on your keyboard.
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Automatically Check Spelling

As you enter text in a spell check enabled text field, the spell checker automatically checks
the spelling of each word. If a misspelled or questionable word is identified, the spell
checker uses a wavy red underline to indicate a possible spelling error. Using the contextual
menu, indicate how you want the spell checker to handle the possible spelling error.

How to Automatically Check Spelling
1. Do one of the following:

e If using a one-button mouse, press CONTROL+click a word with a wavy red
underline. The contextual menu appears.

e If using a two-button mouse, right-click a word with a wavy red underline.
The contextual menu appears.

2. Do one of the following:
e Click the spelling correction you want.

e Click More Suggestions to view additional suggested spelling corrections for
the word, and then click the spelling correction you want.

e Click Ignore All to skip all instances of the word. Note that the next time you
launch PowerTeacher gradebook, the word will appear with a wavy red
underline.

e Click Add to Dictionary to add the word to your spell check dictionary,
such as proper names, technical terms, acronyms, and so on. The next time
you launch PowerTeacher gradebook, the word will not appear with a wavy
red underline, as it is now included spell check dictionary.

e Click Cancel to close the contextual menu.

Note: If using Ignore All, This option is session specific.

Check Spelling

In addition to automatically checking the spelling of each word as you enter text in a spell
check enabled text field, you can use the Check Spelling function to perform a complete
spell check of the field. If misspelled or questionable words are identified, the spell checker
uses a wavy red underline to indicate the possible spelling errors. Using the Check Spelling
window, indicate how you want the spell checker to handle each possible spelling error.

How to Check Spelling

1. From the gradebook menu bar, choose Tools > Check Spelling. The Check
Spelling window appears. The first the misspelled or questionable word appears in
the Not in Dictionary field.

2. Do one of the following or edit the information as needed:

e To select one of the suggested spelling corrections, click the replacement
word in the Suggestions list box, and then click Change or Change All.

e To manually enter the spelling correction, highlight the word, enter the
correction, and then click Change or Change All.
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3. Repeat for each misspelled or questionable word. Once you have made your
corrections, the Check Spelling window closes.
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Preferences

About Preferences

Use Preferences to customize various aspects of PowerTeacher gradebook, including the
Final Grade column of the Scoresheet window, the Class List in the Classes pane, and Spell
Check.

Set Grading Preferences

Use the Grading tab on the Preferences window to customize what final grades appear in
the Final Grade column on the Scoresheet window. If displaying percent or points earned,
you can indicate whether you want the final grade score rounded or truncated, as well as
the number of decimal places you want to appear.

How to Set Grading Preferences

1. From the gradebook menu bar, choose PowerTeacher Gradebook > Preferences.
The Preferences window appears.

2. Click the Grading tab, if not already selected. Grading preference information
appears.

3. Edit the information as needed.
Click OK to save your changes.

Note: Alternately, you can press ENTER or RETURN on your keyboard.

Set Section Preferences

Use the Section tab on the Preferences window to define how you want section information
to appear in the class list in the Classed pane and in what order.

How to Set Section Preferences

1. From the gradebook menu bar, choose Gradebook > Preferences. The
Preferences window appears.

Click the Section tab. Section preference information appears.
Edit the information as needed.
Click OK to save your changes.

Note: Alternately, you can press ENTER or RETURN on your keyboard.
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Classes

About Classes

The Classes pane appears in the upper-left corner of the PowerTeacher Gradebook window
and includes the Term Selector and Class List.

Select Terms

When you first launch PowerTeacher gradebook, the current full year term appears in the
[Term Selector] pop-up menu. The pop-up menu displays current, future, and past year
terms, as well as any lower level terms within a term.

How to Select a Term

On the main PowerTeacher Gradebook window, choose a term from the [Term
Selector] pop-up menu. Classes for the selected term appear.

Note: The selected term becomes the new default setting.

Select Classes

When you first launch PowerTeacher gradebook, the Class List displays classes for the
current term. The first class in your daily schedule is highlighted.

When selecting subsequent classes, the window that appears is the last window in which
you were working. For example, if you are working in the Assignments window and need to
switch to another class, when you select that class, the Assignments window for the
selected class appears.

Note: Information that appears in the class list is defined by your section preferences. For
more information, see Set Section Preferences.

How to Select a Class

On the main PowerTeacher Gradebook window, select a class from the Classes pane.
The window in which you were last working refreshes for the sele